
Barogram, Thermogram Hygrogram and Pluviogram Roll-Scanning Program User’s 

Barogram, Thermogram 
Hygrogram and 
Pluviogram Roll-Scanning 
Program User’s Manual

Pedro J. Restrepo Ph.D. P.E



2 Barogram, Thermogram Hygrogram and Pluviogram Roll-Scanning Program User’s 



Barogram, Thermogram Hygrogram and Pluviogram Roll-Scanning Program User’s 



4 Barogram, Thermogram Hygrogram and Pluviogram Roll-Scanning Program User’s 



Contents

i

Contents

Contents ............................................................................................................................ i
List of Figures ................................................................................................................. iii
Introduction.......................................................................................................................1
 Main Screen Description .................................................................................................1

Graphic Display Area ................................................................................................1
File Information Panel ...............................................................................................3
Quick Scroll ...............................................................................................................3
Time Input, background, grid and line Colors  and pop-up Action Panel display ....4
Control Point Input Panel ..........................................................................................5

Important note: .....................................................................................................5
Menu Description .............................................................................................................7

File Menu ..................................................................................................................7
High-level Description. ........................................................................................7
Load Image ..........................................................................................................8
Next Image... ........................................................................................................8
Setup ....................................................................................................................9
Approve and Save... .............................................................................................9
Exit .......................................................................................................................9

Edit Menu ..................................................................................................................9
Trace By Hand .....................................................................................................9
Edit Hand Trace Points. .......................................................................................9
Edit Single Data Point ..........................................................................................9
Edit Multiple Data Points ..................................................................................10

View Menu ..............................................................................................................10
Description .........................................................................................................10
Rotate Left .........................................................................................................10
Rotate Right. ......................................................................................................10
Zoom Out ...........................................................................................................10
Zoom In ..............................................................................................................11
Original Image ...................................................................................................11
Show Hand Trace. ..............................................................................................11
Show Control Points ..........................................................................................11
Show Data Points ...............................................................................................11
Grid Overlay ......................................................................................................11
Re-Display .........................................................................................................11

Usage Example ...............................................................................................................13
Load a File ...............................................................................................................13

Open Image Dialog ............................................................................................13
Selecting the Chart Type ....................................................................................13
Selecting the Line Color ....................................................................................13



Contents

ii

Selecting the Color of the Marks .......................................................................13
Change Orientation ..................................................................................................14
Enter Dates ..............................................................................................................14

Left and Right Date and Time ...........................................................................14
Starting and Ending Date and Time ...................................................................14

Selecting Background, Grid and Line colors ..........................................................14
Pick background, grid and line colors. ..............................................................14

Enter Control Values ...............................................................................................14
Observation Values ............................................................................................14
Grid Points on the Left .......................................................................................15
Grid Points on the Right ....................................................................................16

Scanning the Chart ..................................................................................................16
Done button. .......................................................................................................16
Scan Button. .......................................................................................................16

Editing the Scanned Line: single point ....................................................................18
Editing muliple points .............................................................................................19

Selecting First Point, Last Point and New Point Location ................................19
Hand Tracing the Observations ...............................................................................20



List of Figures

iii

List of Figures

FIGURE 1. Typical Mechanical Barograph...............................................................1

FIGURE 2. Main Screen ............................................................................................2

FIGURE 3. Chart Information Input Panel ................................................................3

FIGURE 4. Quick Scroll Arrows ...............................................................................3

FIGURE 5. Time and Grid Information Input Panel .................................................4

FIGURE 6. Background color selection notice..........................................................5

FIGURE 7. Control Points Data Input Panel .............................................................6

FIGURE 8. Control Point Input Notice......................................................................6

FIGURE 9. Control Point Display Marks ..................................................................6

FIGURE 10. Completed Control Point Marks ............................................................. 7

FIGURE 11. Request to verify .....................................................................................7

FIGURE 12. File Menu................................................................................................ 8

FIGURE 13. Load Image Dialog .................................................................................8

FIGURE 14. Data Not Saved Warning Message .........................................................9

FIGURE 15. Edit Menu ...............................................................................................9

FIGURE 16. View Menu ...........................................................................................10

FIGURE 17. Original Image With Time Axis along the Y direction ........................11

FIGURE 18. Image Rotated to the Left (90o)............................................................12

FIGURE 19. Grid Overlay Display Options Window ...............................................13

FIGURE 20. Different Colors for the Program Marks...............................................14

FIGURE 21. Selecting a Control Point. .....................................................................15

FIGURE 22. Selecting a Control Point. .....................................................................15

FIGURE 23. Display of Properly Selected Control Points ........................................16

FIGURE 24. Scan Notice ...........................................................................................16

FIGURE 25. Scanned Values at the Beginning and at the End of the Data Line. .....17

FIGURE 26. Scanned Values of a Higher Resolution Chart Image. .........................17

FIGURE 27. Effect of a Faint Line, and/or of Similar Color to the Grid. .................18

FIGURE 28. Single Point To Move Notice ...............................................................18

FIGURE 29. Selected Single Point To Move ............................................................18

FIGURE 30. Selections of Points for Multiple Point Move ......................................19

FIGURE 31. Selected First and Last Points to be Re-scanned (Moved) ...................19

FIGURE 32. Re-scanned Segment.............................................................................20

FIGURE 33. Pluviogram Chart (Segment) ................................................................20

FIGURE 34. Hand-tracing Notice..............................................................................21

FIGURE 35. Hand-traced Line (segment) .................................................................21

FIGURE 36. Scanned points from Hand-traced line..................................................21



List of Figures

iv



Introduction

1

Introduction

Until advances in solid state electronic made it possible to record meteorological boser-
vations in digital format, those observations were recorded on paper charts attached to a 
rotating drum. A stylus with a pen at one end pivoted with respect to a fixed point on the 
other end. (Figure 1). Since the sylus pivots on one end, the recording on the drum does 
not result on a rectilinear grid. The meteorolgical variable may vary on the vertical axis 
on a linear form, as is the case of barograms and thermograms, (the horizontal lines are 
straight and equally separted, or a non-linear fashion as is the case of hygrograms, 
where the separation between the lines varies with the observed value. 

Because of the curvature of the chart, it is necessary to calculate the time along a curved 
line. 

This program accomplishes that once some information is entered by the user. This doc-
ument explains how to do that.

 Main Screen Description

GRAPHIC DISPLAY AREA Figure 2 shows a low-resolution image of the main screen. The top of the screen dis-
plays the image from which the meteorological values of the observations will be 
extracted. Also, the menu on top allows the user to execute all the options of the pro-
gram. 

FIGURE 1. Typical Mechanical Barograph
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FIGURE 2. Main Screen
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FILE INFORMATION PANEL The lower left of the screen (Figure 3) shows the Chart Information Panel. It contains 

one button for loading the scanned image and one to exit. There are three radio button 
boxes. The top one tells the program what type of chart is being displayed. The middle 
one allows the user to indicate the color of the recorded line that needs to be followed to 
extract the values of the meteorological observations There are three typical colors, 
Red, Green and Blue, and on option marked with a “?”. Selecting this option allows the 
user to select the color of the line when it is not clearly one of the other colors. This is 
explained later on. In the example in Figure 3, the chart is a Thermogram with a black 
data line, and we want the mark colors to be green. The marks include the control mark 
and the line scanned by the program. See “Usage Example” on page 13.

The third radio group box lets the user select the color for the marks to be placed by the 
program on top of the chart. That includes the line that the program detected, the loca-
tion of the values the program identified, and the marks used to determine the parame-
ters of the curved grid. The observations start at 9:00 AM on the 7th of July, and end at 

QUICK SCROLL Figure 4 shows two arrows. The left arrow allows for quick scrolling of the chart dis-

play window to the left or to the right. 

FIGURE 3. Chart Information Input Panel

FIGURE 4. Quick Scroll Arrows
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TIME INPUT, 
BACKGROUND, GRID AND 
LINE COLORS  AND POP-UP 
ACTION PANEL DISPLAY

The middle panel (Figure 11) allows the user to enter 4 pieces of time information. The 

top two pieces are used by the program to define the grid parameters. Those include 
parameters of the curvature of the grid and the time difference between the beginning 
and the end of the chart. The other two dates tell the program at what time the recorded 
line starts, and at what time it ends. The format for the dates is day/month/year, 
hour:minute. On Figure 11, the entered times tell the program that the left time to be 
used for grid calculations is the 7th of July of 1954 at 9:00 AM, and that the right time is 
the 9th of July of 1956 at 10:00 AM. The beginning of the recorded line is at 9:30 AM 
and it ends on the 9th at 9:15 AM. It is advisable to select the left and right times that do 
not have symbols nearby. For instance, in the example figure, the 8:00 time has the 
value of the Y axis. That’s why the 9:00AM time was chosen. 

There are three small boxes at the bottom of the panel, marked as BG, Grid and Line, 
for Background Color, Grid Color and Line Color. The program requires that the user 
selects the color of the background, the color of the grid, and the color of the data line. 
To select the image background color the user clicks on the small square above the title 
“BG.” The program displays a blinking red label on a yellow background.(Figure 6). 
The user then clicks on an area of the chart that is representative of the background 
color and the program stops the blinking and show the bacground color on the small 
squre box. Similarly, the user selects the color of the grid and of the data line when the 
user selected the “?” option on the Chart Information Input Panel (Figure 3).

The “Done” button informs the program that the user is ready to enter the control point 
information on the bottom right panel. One the 4 dates are input and the colors have 
been chosen, the user presses the “Done” button to enabled the right-most panel for 
input.

FIGURE 5. Time and Grid Information Input Panel
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CONTROL POINT INPUT 
PANEL

After the user presses de “Done” button shown in Figure 5, the bottom right panel is 
enabled for data input. This panel (Figure 11) is used to enter the values and corre-
sponding coordinates on the screen of the control points. “Control Points” are specific 
points on the grid used by the program to determine the time span of the chart, on the 
horizontal direction, and the values of the meteorological variable on the vertical direc-
tion. Figure 11 shows the “Values” columns with 5 values entered. For this particular 

case, they range from  -10oC to +30oC.

Important note:  The program requires a minimum of 5 values, and will accept up to 
13 values. It is also important to include the top and bottom values, even if the observa-
tions do not reach those points. This is required to get the best mathematical approxima-
tion to the curved vertical axis in barograms, thermograms and hygrograms. 
Pluviograms don’t have the curved vertical axis, but also require  the control points to 
define image skew on the scan, and the vertical scale.

There are two more columns, “Left” and “Right” which are used to locate the control 
points. Initially, the cells within those columns contain only the “?” symbol to indicate 
that values in those cells have not been chosen. To choose a control point, click on the 
cell. It is advisable to click first on the top cell of the “Left” column. which, for baro-
grams and thermograms correspond to the bottom value. In the case of the image shown 

in Figure 2 is -10oC. It is important to select points Once the user clicks on that cell, the 
cell contents changes to “Select” and the program displays a yellow message indicating 
that one control point is being selected (Figure 11). The user needs to click on the image 

to instruct the program where the control point lies. For this example, the -10oC the user 

goes along the 9:00 AM line and clicks near the intersection with the -10oC. The con-
tents of the cell changes to “Done!”, and the program places a cross marking the control 
point . Figure 11 shows the location of the left-hand-side control points corresponding 

to -10oC and 0oC.The program also places the value from the corresponding input panel 
to the left of the mark (a), and on the right side of the chart image (b). Notice that the 
user still needs to mark the location of the control points on the right hand side. The pro-
cess is repeated on the left and right sides of the chart. (Figure 11).

FIGURE 6. Background color selection notice
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Once the user has completed entering the left and right control points, the “Done” but-
ton on that panel is enabled. Clicking on it, the program carries out the internal calcula-
tions to follow the curve Y axis. It asks the user to verify that the calculations are correct 

FIGURE 7. Control Points Data Input Panel

FIGURE 8. Control Point Input Notice

FIGURE 9. Control Point Display Marks

a) Left Side b) Right side
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(Figure 11). The Scan button is now enabled.  See “Usage Example” on page 13.for a 

details on the actual scanning process.

Menu Description

FILE MENU High-level Description.  Figure 12 shows the File Menu on the top left of the screen. 
This section describes the menu options at a high level. A more detailed description, 
including its use is found in detail in the “Usage Example” on page 13

FIGURE 10. Completed Control Point Marks

a) Left Side b) Right side

FIGURE 11. Request to verify 
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Load Image. Selecting the “Load Image...” menu option the program displays the 
Image Load Dialog (Figure 13).

Next Image... This option is enabled once an image has been solved and processed. It is 
very common to process images in a sequencial manner, such that an image is followed 
by the very next image. The program saves some of the information, and, optionally, 
assumes the dates of the new file. 

FIGURE 12. File Menu

FIGURE 13. Load Image Dialog
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Setup. (Reserved for future releases)

Approve and Save... Once an image has been successfully scanned and the observation 
values have been extracted, the user selects this option to save the results to a file with a 
given name. The file is saved on comma-separated values (CSV), with one day per line. 
At 15 minutes interval, there are then 24*4=96 values on a line. The program displays 
the File Save Dialog. similar to the one in Figure 13.

Exit. This option leaves the program. If the data has not been saved, the program issues 
a warning message (Figure 14).

EDIT MENU Trace By Hand. Figure 15 shows the Edit menu optiokns. The first option, “Trace By 

Hand” is very useful when the data line is not well defined, or when the color happens 
to be very close to the color of the background or of the grid. For pluviograms, “Edit By 
Hand” is required. Again, please refer to “Usage Example” on page 13 for details and 
examples.

Edit Hand Trace Points. This option allows the user to modify the location of the ver-
tices of the hand-traced line.

Edit Single Data Point. Once the program has completed scanning a line it is possible 
that the locations of some data points be marked outside of the data line. Man-made 

FIGURE 14. Data Not Saved Warning Message

FIGURE 15. Edit Menu
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marks on the charts, vibration on the stylus making the data line, dirt or spots on the 
chart,  or not enough differentiation between the line color and the grid may be the 
cause for points to be misplaced.

Edit Multiple Data Points. On occasion, a series of points are misplaced,. This opption 
allows the user to indicate points that must be re-scanned.

VIEW MENU Description. Figure 16 shows the “View” Menu. It allows the user to select to rotate the 

image 90o counterclockwise (left) or clockwise (right), and what to display in addition 
to the chart on the main window.

Rotate Left. In many cases the image will appear with the time coordinate running on 

the vertical (Y) direction.. (Figure 17)1.  The program requires that the time coordinate 
be set along the horizontal (X) direction. The Rotate Left option allows the user to rotate 
90 degrees counterclockwise (Left) as shown in Figure 18.

Rotate Right. This option allows the user to rotate the image counterclockwise.

Zoom Out. This option is not impleented in the program’s current version.

1. Incidntally, notice that, in its current version, the program does not zoom in or out, 
but displays horizontal and vertical scroll bars to allow the user to move around the 
image

FIGURE 16. View Menu
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Zoom In. This option is not implemented in the current version of the program

Original Image. This option instructs the program to display the original image, after 
the rotation operation has been performed. In other words, if the image required rota-
tion, it will be displayed rotated. 

Show Hand Trace. When the user has traced the data line, this option, when checked, 
displays it. If not checked, the hand-trace is removed from the main window. Clicking 
on it toggles the display checkbox.

Show Control Points. If the user needs to revisit the control points location, checking 
this option allows those to be displayed or hidden if they  were displayed.

Show Data Points. Afte the program completes the scanning of the data trace, the 
points along the data line every 15’ are displayed if the option is checked.

Grid Overlay. This option has a submenu: “Visible”, if checked, allows the grid, as 
determined by the program, to be overlaid on top of the original image. Grid Settings 
opens a pop-up window for the user to select the Grid overlay line width and the time 
between Y axis axes.(Figure 19). 

Re-Display. This option shows the chart again, with all the selections that have been 
checked.

FIGURE 17. Original Image With Time Axis along the Y direction
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FIGURE 18. Image Rotated to the Left (90o)
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Usage Example

LOAD A FILE Open Image Dialog. Clicking on the “Load Image” button or on the “Load Image...” 
in the File menu  option displays the Image Load dialog screen (Figure 13).

Selecting the Chart Type. The image type is selected next among the 4 options (Baro-
gram, Thermogram, Hydrogram or Pluviogram).

Selecting the Line Color. The program provides 4 specific-color options (Red, Green, 
Blue, Black) and one undefined colr (?). If the line color is well-defined, selecting one 
of the specific colors will work well. If it doesn’t clearly belong to one of the options, 
the “?” allows the user to specify the color in the next panel.

Selecting the Color of the Marks. The marks are placed by the user to inform the pro-
gram about skew of the scanned image and for the programm to compute the vertical 
scale of the chart. It is a good idea to select a marks color that has a good contrast with 

FIGURE 19. Grid Overlay Display Options Window
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the color of the grid. Figure 20 shows how the marks are displayed under different col-

ors.

CHANGE ORIENTATION The next step is to rotate the image, if necessary. (Refer to Figures 17 and  18). It is 
quite common that the image is oriented such that the Time coordinate of the chart is 
located on the Vertical direction. The program requires that the image be rotated so that 
the time coordinate be located along the horizontal direction. The two first entries of the 

“View” menu option allow the user to rotate the image to the left (90o counterclock-

wise) or to the right (90o clockwise).

ENTER DATES Left and Right Date and Time. The next step is to enter 4 required dates. The Left and 
Right dates inform the program how the time scale in the chart translates into coordi-
nates (pixels) of the scanned image.

The Starting and Ending time informs the program where the data starts. Notice that in 
the program, all dates are entered with the DD/MM/YYYY HH:MM format.

Choose a time axis that does not have numbers or hand-made marks in areas where the 
selected time axis crosses the horizontal constant data value lines. For the chart shown 
in Figure 2 the best “left” time is 9:00 AM. For the chart shown in Figure 18 the 
8:00AM axis is fine, since the marks do not interfere at the intersections between the 
8:00AM line and the constant horizontal data axes.

Starting and Ending Date and Time. Starting Date and Time tells the program at 
what time within the date the data traced commenced, and the Ending Date and Time is 
the last time in which the data trace was recorded.. Enter it the same way the Left Date 
and Time were entered.

SELECTING BACKGROUND, 
GRID AND LINE COLORS

Pick background, grid and line colors.  At this point, it is necessary to tell the pro-
gram what are the colors of the Background, Grid and line. (See “Time Input, back-
ground, grid and line Colors and pop-up Action Panel display” on page 4.). Repeat the 
process to select the grid and line colors. For hand-traced lines, just select the line color 
used in tracing the line. To select the line color if scanning the original data line, click 
on the square box above the “Line.”  The square and the Line Color selection notice will 
blink until the user clicks on the line or cancels the selection.

ENTER CONTROL VALUES Observation Values. These values correspond to the horizontal axes on the chart. For 

the temperature chart, we chose values from -10oC to +30oC, even though the recorded 

temperature doesn’t get any colder than 10oC. This is advisable, because of the curved 

FIGURE 20. Different Colors for the Program Marks
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axes the farther apart the data points are, the better computation of the time coordinate 
will be. Remember than the program requires at least 5 points, and at most 13.

Grid Points on the Left. 

Once the values have been entered, the user must tell the program which are the coordi-
nates on the chart that correspond to the values on the “Values” column of the spread-
sheet, and to the time selected on the “Left Date and Time” in Figure 5 on page 4. To do 
that, the user clicks on the cell within the “Left” column and to the right of the “Value” 
cell to which the control point belongs. The program will change the “?” on the cell with 
a “Select...” text and displays the Control Point Selection Dialog, (Figure 8 on page 6), 
which includes the value and the date that will correspond to that control point. 
Figure 21 shows that the user is going to tell the program where the control point that 

corresponds to -10oC and the 7/7/1954 at 9:00AM is located. The user then will click 

near the intersection of the Y axis that corresponds to the “Left Date and Time” entered 
and the value to the left. The program will automatically look for the closest intersec-

tion. Figure 22 shows where a user may place a mark (a), and where the program will 
properly put it, right at the major intersection next to where the user clicked (b). At the 
same time, the spreadsheet cell contents will change from “Select...” to “Done!”. Occa-
sionally, the program can’t find the exact intersection and the mark is a little off. The 
user can solve that problem by clicking again on the cell that corresponds to the point in 
error. The program will now change the text from “Done!” to “Select...” The user now 
clicks again where the mark should go while simultaneously pressing the CTRL key on 
the computer keyboard. This overrides the program’s selection of where the mark goes 
and places it exactly where the user clicked.

FIGURE 21. Selecting a Control Point.

FIGURE 22. Selecting a Control Point.

a) Where a user                    b) Where the 
    may click                           mark is placed
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The remaining control points are selected in the same manner.

Grid Points on the Right. The procedure to select the control points on the right is 
identical to the one on the left. Just make sure that the Y axis corresponds to the dates 
and time selected in Figure 5 on page 4.

SCANNING THE CHART Done button.  Once all the control points are selected, the program enables the “Done” 
button. By clicking it, the program does the internal calculations required for properly 
the observation values and the times at which they were taken. Once this process is fin-
ished (in a fraction of a second), the program requests that the user verifies the location 
of the control points (Figure 11 on page 7). If the control points were properly entered, 
the program places a circle precisely centered on the cross. Figure 23 shows three of the 

five points in this example. In all of them, the circles are perfectly centered on the 
crosses. Once the user clicks the “OK” button on the verification dialog, (Figure 11 on 
page 7), the program enables the “Scan” button.

Scan Button. As already mentioned, clicking on this button activates the Scan Notice 
(Figure 24) and allows the user to start the data line scanning by clicking on the line. 

The user should click on the line as close as possible to the “Start Date and 
Time”(Figure 5 on page 4).

In this case, the line color is black. The marks are green. Figure 25 shows the scanned 
values as circles with the same color as the marks. As the automatic data line is scanned, 
the program writes a thin line over the data line that shows where the program detects 
the data line. Figure 26 belows the detected line as a red line over the blue original line. 
Scanned values are extracted every 15 minutes, starting from the Starting Date and 

FIGURE 23. Display of Properly Selected Control Points

FIGURE 24. Scan Notice
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Time and ending at the Ending Date and Time. The left and right images show the val-
ues at the beginning and end of the scan.

When the original chart is scanned1 at a higher resolution, both time lines and value 
lines are farther apart.. Figure 26 shows the data values, in red, extracted from a higher 

resoultion image. 

1. Please notice that we use “Scan” for both getting the original chart into an image, done with a 
scanner, or for getting the data values from the data line by this program. In this case, a “higher 
resolution scan” refers to the resolution set when scanning the original chart by a scanner.

FIGURE 25. Scanned Values at the Beginning and at the End of the Data Line.

FIGURE 26. Scanned Values of a Higher Resolution Chart Image.
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EDITING THE SCANNED 
LINE: SINGLE POINT

In some cases, the data line is very faint, and/or its color is very similar to the grid color.  

Figure 27 shows how that affects the data extraction. Rather than following the data 
line, the program went along grid lines, and reconnected with the data line. To illustrate 
how to fix that problem, we first select to move the last point, currently on top of the “5” 
label back to the line. 

to do this, go to the Edit Menu and select “Edit Single Data Point”. The program dis-
plays the Single Point To Move Notice (Figure 28). Once the user clicks on the point, 

the color turns to black. Figure 28 shows on the left the selected point to be moved (a) 
and on the right, the point after being moved (b).

FIGURE 27. Effect of a Faint Line, and/or of Similar Color to the Grid.

FIGURE 28. Single Point To Move Notice

FIGURE 29. Selected Single Point To Move

a) Before Move                                                            b) After Move   
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EDITING MULIPLE POINTS Selecting First Point, Last Point and New Point Location. When asking the pro-
gram to re-scan points that were missed, the user selects the “Edit Multiple Data Points” 
from the Edit menu. The program displays a dialog box that allows the user to select the 
first and last points to be re-scanned, and the location of the first point. Notice that, here, 
we choose as the Last point the same point that we just moved in the previous step. In 
reality, it can be any other point at or beyond the points that need correction.Figure 30 

shows the dialog box. Clicking on the “First Point” and “Last Point” radio buttons lets 
the user select the first and last point that need to be re-scanned, respectively. Both 
points markers are now in Black color (Figure 31). It goes without saying that the “First 
Point” to be re-scanned should be to the left (earlier in time) of the “Last Point”. 
Figure 31 shows both points now colored in black. Clicking the “New First Point” radio 

button let’s the user click on the chart what the location of the new point should be. You 
should be careful to follow the curved time lines when clicking on the new button. 
Figure 32 shows the line after the re-scanning.

FIGURE 30. Selections of Points for Multiple Point Move

FIGURE 31. Selected First and Last Points to be Re-scanned (Moved)
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HAND TRACING THE 
OBSERVATIONS

This version of the program requires that the pluviograms data lines be hand-traced. 
For other chart types, the hand tracing is optional. Figure 33 shows a segment of a plu-

viogram. The practice in this Weather Service is to replace pluviogram charts only when 
there is precipitation.. To do this, they add by hand 10 mm after each day without rain, 
as a way to separate observations from different days. While this practice does help with 
the costs, it makes it confusing for a computer program to follow the line corresponding 
to the date that does have the precipitation event or events. The other feature shown in 
Figure 33 is the familiar spike on the data line that happens when this type of pluvio-
graph empties its tank. To scan these lines we hand-trace the data line with a different 
color than the original data line.

To hand-trace the observations line, choose “Trace by Hand” from the Edit Menu. The 
program displays the Hand-tracing Notice (Figure 34). The user then clicks on the 
Observation Data Line that is going to be hand-traced. the user should be careful that the 
beginning of the hand-traced line is to the left (earlier) than the existing data line, to 
make sure that the program does find the first data point. If the user makes a mistake, 
the “Undo” button takes the line to the previous point. To finish the tracing, the user 

FIGURE 32. Re-scanned Segment

FIGURE 33. Pluviogram Chart (Segment)
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clicks on the “End Trace”button. To cancel the hand trace altogether, the user clicks on 
the “Cancel” button.

Figure 35  shows a detail of the hand trace. However, immediately after completing the 

hand trace by clicking on the “End Trace” button, the program places the markers on top 
of the identified data points. 

FIGURE 34. Hand-tracing Notice

FIGURE 35. Hand-traced Line (segment)

FIGURE 36. Scanned points from Hand-traced line
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